
KROY®

Owner’s Manual
Read this manual before using your K5100

K5100 Handheld Label Printer

Toll Free 800.776.5769 Order Number 2561100
Visit www.kroy.com Rev A 6/04



Introduction

Kroy Limited Warranty

Kroy LLC ("Kroy") warrants its labelling system equipment against defects in material and workman-

ship for a period of six (6) months from the date of purchase. At no charge to the customer except for

inbound freight to Kroy's service centre, Kroy will, at Kroy's option, repair or replace any product

determined to be defective. Kroy will pay return UPS ground charges. A purchase receipt or other evi-

dence of purchase will be required before warranty service is rendered. This warranty does not cover

cosmetic damage or any damage caused by accident, misuse, abuse, negligence or modification or

attempted repair by anyone other than Kroy or a Kroy authorized repair agent. THERE ARE NO

EXPRESS WARRANTIES EXCEPT AS SET FORTH IN THIS PARAGRAPH.

KROY SHALL NOT BE LIABLE FOR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES FOR
BREACH OF ANY EXPRESS OR IMPLIED WARRANTY ON THIS PRODUCT. ALL EXPRESS AND
IMPLIED WARRANTIES, INCLUDING WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE LIMITED TO THE APPLICABLE WARRANTY PERIOD SET
FORTH ABOVE.

Some states do no allow the exclusion or limitation of incidental or consequential damages, or limita-
tions on how long an implied warranty lasts, so the above exclusions or limitations may not apply to
you. This warranty gives you specific legal rights, and you may have other rights which vary from
state to state.

If a problem develops with your Kroy labelling system during or after this warranty period, you may
contact Kroy customer service at 800.729.5769.

FCC Notice

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to part 15 of the FCC Rules.  These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful intereference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case
the user will be required to correct the interference at his own expense.

Any changes or modifications not expressly approved by the manufacturer could void the user’s
authority to operate the equipment.

CDC Notice

This digital apparatus does not exceed Class A limits for radio noise for digital devices as set out in
the radio interference regulations of the Canadian Department of Communications.

The K5100 Printer and Cartridges are protected by U.S. Patents including:
5,411,339 5,533,818
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Getting Started
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Contents of Box

(1)K5100 Handheld Label Printer (1) Owner’s Manual and (1) CD-

ROM with KLDS Software and Drivers

(1) AC Adapter with Power Cord (1)Serial Cable
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Printer description

Figure 1 : Top View of Printer

Figure 2: Left Side of Print
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Important Safety Precautions

When using your printer, always follow these important safety precautions:

1.   Read all instructions carefully.

2.   Do not immerse the printer in water or other liquids, you could receive an electrical shock.

3.   Do not apply adhesive labels to your skin.

4.   Do not put objects onto or into the printer.

5.   Do not expose to high temperatures or high humidity. Never leave on the dashboard or in the

trunk of your car.

6.   Do not use in dusty places and avoid direct exposure to sunlight and rain.

7.   Do not pull on the tape, you could damage the tape cartridge.

8.   Do not attempt internal repairs to the printer. If service or repair is needed, contact a qualified

Kroy service representative.

9.   Do not touch the printhead ceramic or rollers with your fingers.
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Connecting AC Adapter

The supplied AC adapter can be used to power the K5100. Warning: Only use the AC adapter

provided with this machine. Use of any other AC adapter will damage your K5100, and void the

warranty.

Connecting the AC Adapter

1.   Insert the AC adapter plug into the AC adapter jack on the left side of the

machine.

2.   Plug the other end of the AC adapter into the nearest standard electrical outlet.

Figure 3: AC Adapter Connection

WARNING: K2500, K3000-PC and K240 AC adapters are NOT compatible with the K5100.
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Installing Batteries (Optional)

Installing Batteries (Optional)
Your K5100 printer can optionally operate with six 2.5 Ampere-hour “C” size nickel cadmium batteries
for primary power. Do not replace with other type batteries. These batteries can be purchased from
Kroy or your Kroy dealer as accessory Part# 2449300 (6 pack Ni-Cd battery).

WARNING: Do not dispose of nickel-cadmium batteries in fire, mutilate, short-circuit, mix with other
battery types. Batteries may explode, release toxic material, or get hot and cause personal injury.

Removing the Yellow Elastomer Jacket
1. Pull the jacket down from the top of the printer until clear of the top portion of the printer.
2. While holding the printer from the bottom, grab the top portion of the printer and lift it out of the

jacket.
3. To replace the jacket reverse steps 1 and 2.

Note: The jacket must be removed to install batteries.

Installing the Nickel-Camium Batteries
1. Remove the battery cover by pushing down on the arrow and sliding it off the base in the

direction of the arrow.

2. Insert the batteries according to diagram imprinted on the printer case under the batteries.

3. Replace battery cover.
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Charging Batteries

Charging Main Batteries
The internal Ni-Cd battery charger operates when the AC adapter is connected to the K5100 printer.
The normal complete charge cycle for fully discharged batteries is approximately 8 hours. The three
LED’s at the front of the K5100 printer indicate the internal battery charger status as shown below.

Charge Phase Left LED (Green) Middle LED (Amber) Rigth LED (Green)
No Ni-Cd Battery
Detected

Off Off Off

Battery Detected Fast Flash Off Off
Soft Start Charge Slow Flash Off Off
Charging On Slow Flash Off
Topping Charge On Fast Flash Off
Charge Complete On Off On
Error Fast Flash Off Fast Flash

When the two green LED’s are ON, the charge cycle is complete and the AC adapter can be
disconnected.

If the Error indication is present, the batteries should be replaced.



9

Installing the Supply Cartridge

Figure 4: Installing the Supply Cartridge

1. Wind the ribbon spool on the bottom of the supply cartridge counter-clock wise two full turns in
the direction of the arrow with your finger.

2. Insert cartridge into the cartridge cavity with the lock/release knob turned counter-clockwise
and the excess material threaded in the exit slot.

3. Turn the lock/release knob clockwise to lock the cartridge into place.
4. Press FEED and you are ready to create a label.



Chapter 2
Printing Your First

 Label
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Printing a Label

Turning the Printer On

Use the Power switch located on the left side of the printer to turn the printer on. The following

displays will appear:

        Kroy 5100 _            1: n
         2:

Cursor Movement

The underline seen above is the cursor. The cursor shows you the current typing position. Cursor

keys move the cursor through text without changing it and through options without selecting any. The

left and right cursor keys move left and right, one option or one character at a time; the up and down

cursor keys move the cursor up and down through lines of text, one line at a time.

Adjusting LCD Contrast

The LCD Contrast allows you to lighten or darken the LCD of your printer. To darken the screen, turn

the LCD contrast control clockwise. To lighten the screen, turn the LCD contrast control counter-

clockwise.

Default Printer Settings

When the power is turned on for the first time, there are pre-programmed printer settings. One of

these is the Auto Size feature. This feature auto sizes the text of your label to the current cartridge

supply and size of media. You can find this function by pressing the Size key. You can always turn

auto sizing off and type in a designated size, but for our example we will have auto sizing ON. The

default font is "Block". No other font is installed on your K5100, however, other fonts of your choice

can be downloaded into your K5100. The default justification is left. For more information on

formatting and label setup see Chapter 3.

In the following examples, we have kept the default settings ON.

Type in the text "Cable 2E45"

1: Cable 2E45_
2:

Now that your label is typed, you will press the Print Key and the auto-sizing feature automatically
sizes the text for the cartridge you are using.

Cable 2E45
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To make a two line label, press Enter at the end of line 1 and you will see the cursor go to line 2.
Type in the text "Floor 2C" on line 2.

1: Cable 2E45_ 1: Cable 2E45
2: 2: Floor 2C_

Now that you have two lines typed, press the Print key and the auto-sizing feature automatically sizes
the two lines for you.

Cable 2E45
Floor 2C

To add additional lines, perform the same function again.

Editing Text
You can correct or change characters by using the left and right cursor keys to move the cursor to the
right of the character to be changed. Use the Delete key to delete the character and type in the
correction. Below we changed the “E” on line 1 to "F" in our example.

Move the cursor to the right of "E" on line 1, press the Delete key and type in the letter "F".

1: Cable 2E45 1: Cable 2F45
2: Floor 2C 2: Floor 2C

Adding a Character Style
You can change the style of text previously entered by using the left and right cursor keys to position
the cursor to the beginning of your text. Press the Style key to select your character style of choice.
To turn styles on and off use your Enter key.

In the following example, the cursor is moved to the beginning of the word “Floor" and Bold was
then selected in the Style Menu. Note: Only text to the right of the cursor will be changed.

1: Cable 2F45 Style Menu
2: Floor 2C n Rotate * Bold   Italic

Now that your label has been edited and styled press the Print Key.

Cable 2F45
Floor 2C
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Printing on Shrink Tube

Kroy offers flattened shrink tube cartridges for wire marking. Insert a shrink tube cartridge for this
example.

You will start with a New file. To create a New file, press the File key and select New with the Enter
key. Or use Shift and File as a shortcut.

For our example, we kept Auto Size ON.

Type in the following text "File Server"

1: File Server_
2:

Press the Print key. Cut the shrink tube label and insert the wire.

The tubing can be shrunk around the wire with a heat gun.

For further information on formatting the text of your shrink tube see Chapter 3.
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Printing a Self-Laminating Wire Wrap

Kroy offers self-laminating wire wrap cartridges ideal for marking terminated wires and cables. Insert a
self-laminating wire wrap cartridge for this example.

For our example, we kept Auto Size ON.

You will start with a New file. To create a New file, press the File key and select New with the Enter
key. Or use Shift and File as a shortcut. When using a wire wrap cartridge, this will activate the
automatic rotation feature. Rotation is necessary because the printable area of a wire wrap is vertical
and represents a small portion of the label.

Type in the following text "300E"

1: 300E_
2:

Press the Print key then Feed and you have a wire wrap ready to apply.

Apply the printed portion of the label to your wire and wrap the laminated tail around the wire.

For further information on formatting the text of your wire wrap see Chapter 3.
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Frequently Used Keys

The keyboard is used to enter label text and access menus. You will hear an audible click whenever a
key is depressed. The frequently used keys on the keyboard are described below.

Function keys (File, Font, Size, Style, Repeat), will automatically prompt a list of selections to
choose from. When using some function keys, the printer will display submenus or prompt you for
information. These function keys also act as "toggles" which allow you to turn an option on or off.

The Alt Key accesses special character symbols shown in blue on particular keys. To enter a special
character, (such as A), hold down ALT and press the key of choice at the same time. To abort a print
job, use the Alt and the Print keys together.

The Cursor (Arrow) Keys move the cursor through text without changing it and through options
without selecting any. The left and right Cursor keys move left and right, one option or one character
at a time; the up and down Cursor keys move up and down through lines of text, one line at a time.
When used with SHIFT, the up and down Cursor keys act as Page up (previous label) and Page
Down (next label) keys and the left and right Cursor keys move the cursor one word at a time.

The Caps Key locks capital letters on. Pressing the Caps key again turns off the function. The Caps
key does not effect the number keys.

The Delete Key allows you to cancel functions or escape from menus. Delete erases characters to
the left of the cursor. To Delete an entire line, hold down Alt and the Delete key together.

The Enter Key in typing mode, moves the text or the cursor to the next line. In function mode, the
Enter key selects specific menu options, file names and default printer settings.

The Feed Key advances the tape from the printer.

The Print Key prints the current label and advances the tape far enough to clear the cut mechanism.

The Shift Key capitalises individual letters and accesses the black characters on the number keys
(such as!). Using the Shift and File key clears text allowing you to create a new label.
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Chapter 3

Operating Your
Printer
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Font Function

Using the Font Menu
When you select the Font key the printer displays the default "Block" font seen below. This is the only
font included with the K5100.

Font Menu
n Block

K5100 has the option of downloading fonts from your PC. When you download a font, it will be added
to your Font menu.

Font Menu
n Block_times_arial

Press Enter to accept the current Block font or use the left and right cursor keys to move the cursor to
the left of the font you want and press Enter to select it.

See Downloading Fonts on Pages 43-44 for further information.
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Size Function

Using the Size Menu
Select Size to specify the print size for your text. The printer displays the default Auto Size function
and waits for your entry. Press Delete to accept auto-sizing or type a different size and press Enter.
Valid sizes of 4-72 pt can be entered.

Size Menu Auto Size OFF
Size n 24        * Auto

When printing, the K5100 will show what point size is being printed in the auto size mode. See below.

Printing.....
Auto Size xx pt

If you select Auto Size, the K5100 will automatically adjust the print size based the number of lines of
your label and the width of the label media. If you turn auto size off, the size of the print you select
must take into account the number lines of your label and the width of the media.

    Error
    Size to Small If auto size calculates a point size smaller than 4 point, an

error message will be displayed.

Error If the text you have typed is too large, an error message will
FontSize Too Big     be displayed.

See the table below which can be used as a guide. The table assumes using characters of all the
same size (capital letters). When using characters of vary-size (such as lower case letters or accent
characters) or using character styles (such as bold, italic etc.) the maximum point sizes will vary
slightly.

Tape Size 1 Line 2 Line 3 Line 4 Line 5 Line 6 Line

0.375" 28 pt 11 pt 8pt N/A N/A N/A

0.50" 38 pt 19 pt 12 pt 8pt N/A N/A

0.80" 60 pt 30 pt 20 pt 15 pt 11 pt N/A

1" 72 pt 36 pt 24 pt 18 pt 14 pt 12 pt
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Character Styles

This section explains how to use the Style key to assign text formatting attributes to your label text.
There are three types of text attributes: character, line and page. These attributes, as well as their
defaults and options, are shown in the following table.

Attribute Defaults Options

Font Block Download True Type
Fonts from PC

Size Auto Size On .50" 4-30 point size
.80" 4-55 point size
1"    4-72 point size

Justification † Left Left, Centre,
Right

*Bold Off On, Off

*Italic Off On, Off

*Mirror ‡ Off On, Off

*Vertical ‡ Off On, Off

*Frame Off
Off

Page: On, Off
Line: On, Off

*Underline Off On, Off

Rotate ‡ Off On, Off

* Attributes marked with an asterisk are toggles. † are line attributes. They affect the entire line of text
that the cursor is positioned on. ‡ are page attributes. They affect the entire page (label). All other
attributes (except Frame) are character attributes only and affect the text from the point that the
cursor is positioned.

The following style settings are available on the K5100: Rotate, Bold, Italic,
Underline, Justify, Mirror, Frame and Vertical.

To Select Multiple Styles, with less keystrokes, use the Space key and the cursor keys to turn styles
on and off. For more Shortcuts, See page 24.

Note: When the Style menu is selected, all selections are not visible on the LCD display - you will
have to use your left and right cursor keys to scroll through all the choices.
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The most common character styles used are Bold, Italic and Underline.

To emphasize the text of your label using Bold, move the cursor to the position where you want to
apply the Bold attribute and press the Style key. Use the left and right cursor keys to move the cursor
to the left of Bold and press Enter. When turned on, an asterisk will appear. To turn Bold off, press
Enter again or to exit press Delete.

1: ATTENTION      Style Menu
2:       n Rotate * Bold _Italic

Bold Example:

ATTENTION

To italicize the text of your label using Italic, move the cursor to the position where you want to apply
the Italic attribute and press the Style key. Use the left and right cursor keys to move the cursor to
the left of Italic and press Enter. When turned on, an asterisk will appear. To turn Italic off, press
Enter again or to exit press Delete.

1: ATTENTION      Style Menu
2:       n Rotate _ Bold  * Italic

Italic Example:

ATTENTION

To underline the text of your label using Underline, move the cursor to the position where you want to
apply the Underline attribute and press the Style key. Use the left and right cursor keys to move the
cursor to the left of Underline and press Enter. When turned on, an asterisk will appear. To turn
Underline off, press Enter again or to exit press Delete.

1: ATTENTION      Style Menu
2:           * Underline  _Justify

Underline Example:

ATTENTION
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Other Styles

Other character styles include Mirror, Frame, Justify, Vertical and Rotate.

To reverse the text of your label using Mirror press the Style key. Use the left and right cursor keys to
move the cursor to the left of Mirror and press Enter. When turned on, an asterisk will appear. To
turn Mirror off press Enter again or to exit press Delete. When using mirror image, use clear tape for
best results.

1: ATTENTION      Style Menu
2:           * Mirror  _Frame

Mirror Example:

?OIT?∃TTA

To draw a box around the text of your label using Frame press the Style key. Use the left and right
cursor keys to move the cursor to the left of Frame and press Enter. When turned on, an asterisk will
appear. The printer displays the frame menu and waits for you to select the type of frame you want.
To turn Frame off, press Enter again or to exit press Delete.

   Style Menu
         _Mirror  * Frame       

Once Frame is selected, the Frame Menu will appear. To frame all the text on the label, select Page
by pressing the Enter key. When turned on, an asterisk will appear.

1: ATTENTION Frame Menu
2: EMPLOYEES * Page _Line

Page Frame Example:

ATTENTION
EMPLOYEES
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To frame just a line of text, move the cursor to the line of your text and select Line by pressing the
Enter key. When turned on, an asterisk will appear

1: ATTENTION Frame Menu
2: EMPLOYEES    Page  * Line

Line Frame Example:

ATTENTION
EMPLOYEES

To justify the text of your label using Justify, press the Style key. Use the left and right cursor keys to
move the cursor to the left of Justify and press Enter. The printer displays the justify menu and waits
for you to select the justification of your choice. To exit the Justify menu press Enter or the Delete
key. Note: The default justification is left.

1: ATTENTION Justify Menu
2: PLEASE          *  Left _Centre _Right

Left Justification

ATTENTION
PLEASE

Centre Justification

ATTENTION
    PLEASE

Right Justification

ATTENTION
      PLEASE
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To print the text of your label vertically instead of horizontally using Vertical, press the Style key. Use
the left and right cursor keys to move the cursor to the left of Vertical and press Enter. When turned
on, an asterisk will appear. To turn Vertical off press Enter again or to exit press Delete.

1: ATTENTION        Style Menu
2:             *  Vertical _Rotate

Vertical Example:

To rotate the text of your label using Rotate, press the Style key. Use the left and right cursor keys to
move the cursor to the left of Rotate and press Enter. When turned on, an asterisk will appear. To
turn Rotate off, press Enter again or to exit press Delete.

Rotation and Vertical are not the same. Note: Mirror is ignored when rotation is selected.

1: 300E_                    Style Menu
2:                 *  Rotate  _Bold

Rotate Example:

Auto Rotation
When a self-laminating wire wrap cartridge is installed, the K5100 will automatically rotate and auto
size the text using the instructions below.

You will start with a New file. To create a New file, press the File key and select New with the Enter
key. Or use Shift and File as a shortcut. This will activate the auto rotation feature.
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Label Setup

To select the Label Setup press the Shift and the Style key together. The prompt below will appear.
The menu options are length, cutmark, left margin and vertical margin.

Label Setup
n Length _Cutmark

In the default setting, the Length of a printed label automatically adjusts to fit the length of text. If you
want to specify the length of a label, the Length function allows you to set the length between 0.3"
and 20". To turn Auto off, type in your specific length and press Enter. To exit the length menu
without making any changes press Delete.

Length Menu
Len n  0.3   *Auto

The Cutmark function creates cutmarks along a print job. Use the left and right cursor keys to move
the cursor to the left of Cutmark and press Enter. When turned on, an asterisk will appear. To turn
Cutmark off press Enter again or to exit the menu without making any changes press Delete.

Label Setup
n Length * Cutmark

The Left margin function allows you to increase the size of your left margin by moving text from the
left to the right of your label. The amount is measured in pixels. Use the left and right cursor keys to
move the cursor to the left of Leftmargin and press Enter. A prompt will appear. Use the right and left
cursor keys to select an increment up to 30 pixels. Press Enter to select the increment of choice. See
the example below.

This function is used with die cut labels and self-laminating wire wraps only.

The text seen here   Left Margin
has printed right Margin:  n +5
to the edge.

The text is now adjusted.
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The Vertical margin function allows you to move text from the top to the bottom by pixel on your
label. Use the left and right cursor keys to move the cursor to the left of Vertmargin and press Enter.
A prompt will appear below. Use the right and left cursor key to select an increment up to 30 pixels.
Press Enter to select the increment of choice. See the example below.

ATTENTION Vert Margin
EMPLOYEES Margin:  n +2

The text seen here has printed to
the bottom of the label.

ATTENTION
EMPLOYEES

The text is now adjusted upward on the label.
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Shortcuts and Hot Keys

A Shortcut will provide a direct route to some submenus and options. See the listing below. To use a
shortcut, first press and hold the Shift or Alt key and then press the second key.

Shift + File              Creates a New File / Erases All Text
Shift + Font           Bar Code Menu
Shift + Size             Toggle Auto Size On/Off
Shift + Style             Label Setup
Alt + Style               All Styles Reset
Shift + Repeat         Time/Date Menu
Shift + Delete             Printer Setup
AIt + Print               Stops Print Job
Alt + Delete            Erase Current Line

The Space key can be used to select multiple items on a menu. For example, in the Style Menu, if
you want Bold and Italic on at the same time simply use your cursor key and the Space key to select
these options and then exit the menu using the Delete key.

Hot keys are represented by a capitalized letter in most function key menus (i.e._New _0pen _Save).
For example, the File Menu is selected. By pressing the letter "N", a new file will be selected without
using the cursor keys and the enter key. Hot keys turn menu options on and off. And they also act as
a shortcut to submenus. Note: The function key must be selected first before using the hot key. Hot
keys work only in function mode.

Below is a listing of some of the function menu's hot keys.

FiIe Menu Hot Keys          "J" Justify Menu
“N" New File "L" Left Justify On/Off
“O" Open File Menu           "C" Centre Justify On/Off
“S" Save File Menu           “R” Right Justify On/Off

"M" Mirror On/Off
Size Menu Hot Keys       "F" Frame On/Off .
"A” Auto Size On/Off          "V" Vertical On/Off

Style Menu Hot Keys        Repeat Menu Hot Keys
“R" Rotate On/Off  "S" Sequence Menu .
"B” Bold On/Off               "I" Insert
“I” Italic On/Off               "A" Alpha On/Off - Sequence Start/End
"U” Underline On/Off          "N" Numeric On/Off - Sequence Start/End



27

Multiple Copies and Sequencing

This section explains how to use the Repeat key to print multiple copies of a file or sequence text
either numerically or alphabetically.

Press the Repeat key to make copies or sequence labels. The prompt below will appear.

Repeat Menu
n Sequence _Copies

Select Copies to specify the number of copies you want to print (1-999), Use the left and right cursor
keys to move the cursor to the left of Copies and press Enter. The printer displays the current setting
for this option (see the following example) and waits for your entry. Press Delete to accept the
number of copies shown, or type in your specific number and press Enter. Press Print.

Copies Menu
Copies: n 3

Select Sequence to automatically generate and print labels containing a sequence of one letter or
one to three numbers (101 102 103, ABC....etc.) without having to type the text of each label yourself.
You simply tell the printer what characters to print on the first and last labels and how much to
increment between labels (see following table).

Printing Sequential Labels

Start Stop Increment Individual Labels Printed
1 10 1 1 2 3 4 5 6 7 8 9 10

2 12 2 2 4 6 8 10 12

A J 1 A B C D E F G H I J

a z 4 a e i m q uy

The sequence character takes on the current character attributes previously defined. Optionally, you
can redefine the sequence character's attributes like any other character. Note: You can only define
one sequence type (numeric or alpha) per document/file, but you can place the sequence character in
your document/file once on each line.
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Select Sequence from the menu. The sequence menu will appear.

Sequence Menu
n Insert * Alpha _Num

Use the left and right cursor keys to move to the left of the option you want and press Enter to select
it.

If you choose Alphabetic, the printer prompts you to enter the first letter you want printed (if you
choose Numeric, this prompt reads Start #, you will then need to enter the beginning number). Type
the letter or number you want printed first and press Enter.

  Sequence Start
Start: n  A

If you choose Alphabetic, the printer next prompts you to enter the last letter you want printed (if you
choose Numeric, this prompt will read End #): Type the last letter or number you want printed in the
sequence and press Enter.

   Sequence End
 End:  n C

The printer next prompts you to enter the increment amount. Press Enter.

   Sequence Inc
 Inc: n 1

Next, the sequence menu will appear select Insert by pressing Enter. This will place the sequence
character where you have the cursor next to your text. A black box will be seen where the sequence
will begin. See example below.

1:L1n_
2

For our example, we have the Cutmark On (See page 22) and have selected 2 copies (see page
25).
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Printer Setup

To select the Printer Setup press the Shift and the Print key together. The prompt below will appear.
The menu options are reset, unit of measure, density, auto off, advance cut, language, printspeed and
led contrast.

Printer Setup
n Reset _Unit _Density

Select Reset to restore all factory settings and defaults. To select Reset press Enter or to exit press
Delete.

   1:n
   2:

The Unit of Measure function allows you to choose the unit of measure you want to use for setting
label width and margin. The options are tenths of an inch (default) and millimeters. Select Unit from
the printer setup menu by using the cursor keys and pressing Enter. The unit menu will appear. Use
the arrow keys to move to the left of the option you want and press Enter.To accept the current
setting press Delete.

Unit Menu
  n *lnch  _MM

Select Density to specify the density (0-7) for printing the current label. Density will make the label
darker or lighter per unit measure. The printer displays the current density setting and waits for your
entry. Press Delete to accept the value shown, or use the left cursor key to add density and press
Enter.

           Density Menu
D: # # # # n

If the characters are smeared on a label or are not completely filled in, you can attempt to fix the
problem by adjusting the print density. If the characters are smeared, specify a lower number in the
field; if the characters are not completely filled in, specify a higher number. You may need to adjust
the density after installing a new tape.
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Select Auto Off to activate auto shut off. The factory default is to shut off the printer after 5 minutes of
non-use. When the printer is turned off, all current label text and text attributes settings are saved. All
files in memory are still saved. Press Delete if you decide you do not wish to change the current
setting. Or press Enter to activate auto shut off. When turned on, an asterisk will appear. By default,
this function is off.

The Advance to Cut function advances the label material to the cut position. The default setting is
advance to cut enabled. If you do not need this function you may disable the advance to cut function
by using the cursor keys to move to the left of Advance in the printer setup menu and press Enter.

The Language function allows you to choose from 4 different languages. The default language is
English. Other options are Spanish, French and German. Select Language from the printer setup
menu by using the cursor keys and press Enter. The language menu will appear. Use the cursor keys
to move to the left of the language you want and press Enter. To accept the current setting press
Delete.

  Languages Menu
  * English _eSpanoL _Francai _Deutsch

Printspeed is the rate at which the label advances from the printer when printed.The default
printspeed is unlimited. To specify a printspeed, select PrtSpeed from the printer setup menu by
using your cursor keys and press Enter. The printspeed menu will appear and by using your cursor
keys you can select from the options below by pressing Enter. To accept the current setting press
Delete.

PrtSpeed Menu
* Unlimit _0.5 _0.8 _1.0
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Bar Codes

To print a Bar Code, press the Shift and the Font key together. Use the Bar Code Menu to specify
the type of bar code you want to print.

    BARCODE Menu
 n None _codaBar _Code39 _Ean8 _eAn13_I2of5

    BARCODE Menu
_Upca _uPce_coDe128 _Msiplessey_pdF417

K5100 has ten bar codes built-in. The following table summarizes information on these bar codes.

Bar Code
Type

Valid Characters Checksum
Options

Available

Fixed
Length

Special Restrictions & Other
Information

Codabar 0-9 A - D
. -$/ +%

None, mod 10,
mod 16

<32
characters

First and last characters must always be either
A, B, C, or D. Letters not allowed in body of
bar code

Code 39 0-9 A - Z
    . -$/ +%

space

None, mod 43 <32
characters

Lowercase letters not allowed

EAN-8 0-9 EAN-8 7, 9 or 12
digits

Length varies because of optional 2 or 5 digit
supplemental

EAN-13 0-9 EAN-13 12, 14 or 17
digits

Length varies because of optional 2 or 5 digit
supplemental

Interleaved 2
of 5

0-9 None, mod 10 Even number of
digits

Printer adds leading zero, if needed, to make
the length even

UPC-A 0-9 None 11, 13or 16
digits

Length varies because of optional 2 or 5 digit
supplemental

UPC-E 0-9 None 6, 8 or 11
digits

Length varies because of optional 2 or 5 digit
supplemental

Code 128 128 ASCII
Character Set

None <32
characters

See Appendix D

MSI Plessey 0-9 None, mod 10,
mod 11

< 16
characters

Mode 11 checksum cannot equal 10

PDF417 All ASCII
characters

0 to 400 levels
of security

<700 characters None

After the bar code selection has been made, press the Shift and Font keys together to go back to the
Bar Code menu. The menu will change allowing you to customize the bar code selected using code,
text and resolution.

BARCODE Menu
n Code _Text _Resolution
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Select Code to change the type of bar code you want to print. The printer displays the types of bar
codes available. Use the left and right cursor keys to move to the left of the option you want and press
Enter. If an asterisk displays to the left of the option, selecting it turns the code off.

Depending on the bar code you have selected, some bar codes allow you to choose whether to
include a checksum and change the resolution at which the bar code is printed as well as whether to
print text or the checksum.

Select Text to print text as part of the bar code. Use the left and right cursor keys to move to the left
of the option you want and press Enter. If an asterisk displays to the left of the option, selecting it
turns text printing off. Text is printed in the following manner:

• Code 39, Code 128, Interleaved 2 of 5 and MSI Plessey: text is printed immediately beneath
the symbol.

• EAN8, EAN13 and UPC: text for the number system is printed at the left of the symbol; text for
the product and manufacturer code is printed beneath the symbol; text for the supplemental is
drawn above the symbol.

• PDF 417 has no text option.

Resolution specifies whether you want to print the bar code at normal or high resolution. Use the left
and right cursor keys to select the option you want and press Enter.

Resolution Menu
* Medium  _High

CheckSum specifies the type of error checking you want to use. The type of bar code selected at
Code determines the prompt that displays next. For example, if you selected 12 of 5, the following
prompt displays:

BARCODE Checksum
* Mod10  _Mod16

Some bar code symbologies allow you to print the checksum value as part of the bar code



33

File Management

To select the File Menu press the File key. Use the File Menu to create new files, open files, save
files and delete files.

File Menu
n New_Open_Save_Delete

Select New to create a new document. The printer clears any text displayed on the screen, returns all
attributes to factory defaults and displays a blank edit screen so you can enter new text. To create a
New file, press the File key and select New with the Enter key. Or use Shift and File as a shortcut.

1:n
2:

Select Open to access an existing document you want to edit or print. The printer displays a list of
file(s) you have saved (see the following example) and waits for you to select the file you want to work
with. Press the File key and use the cursors to scroll to the left of Open and press Enter. The Open
File Menu is now displayed. Use the left and right cursor keys to scroll to the left of the file you want
to open and press Enter to select it. See example below.

   Open File Menu
n Address _Job 4048  _ww

Select Save to save the current document. You must save the label you are working on before you
select either New or Open. If you do not save first, it will be lost. Press the File key and use the
cursors to scroll to the left of Save and press Enter. The Save File Menu is now displayed prompts
you to enter a file name.

Save File Menu
n

File names can be any combination of letters and numbers, 8 character maximum, with no
punctuation or file name extensions.
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If you enter a file name for an already existing file, you will see the following message:

Overwrite?
OK? (Y,N)

Press Y to overwrite or N to enter a different file name. If you decide not to save the file, simply press
Delete.

Select Delete to delete files that you no longer need. Press the File key and use the cursors to scroll
to the left of Delete and press Enter. The Delete File menu displays a list of files you have saved
(see the following example) and waits for you to select the file you want to delete. Use the left and
right cursor keys to move the cursor to the left of the file you want to delete and press Enter to select
it. If you decide not to delete a file, simply press Delete.

Delete File
n Address _Job 4048 _ww
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Multiple Page Documents

You can enter multiple labels in a file by using Page Up and Page Down to access additional pages
(labels). In this case, you can think of a file as a single document containing one or more pages
(labels). Each label can be up to six lines.

   1:n
   2:

To start a new page while you are in a file, use the Shift and the Down Cursor key to move to the
next page. A prompt will appear with the page number.

Page 2

To move back to the preceding page, use Shift and the Up Cursor key. When you press the Print
key, all pages in the file will be printed.
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Time/Date Stamp

To select the Time/Date Menu press the Shift and Repeat keys together. Use the Time/Date Menu
to print labels with

    Time/Date Menu
n Time _datE _stamp _setclOck _24Hourmode

To use the Time/Date functions you must first set the real time clock with the local time and
date. This will lock the time and date into memory. This will have to be done once with the exception
of summer and winter time changes.

Select Set Clock to enter the current time and date in the printer. Use the cursor keys to scroll to the
left of Set Clock and press Enter. The prompt below will appear. Use the Up and Down cursor keys
to scroll through the menu.

The information will be entered in the order shown here:

Year_
Month_
Day_
Hour_
Minute_
Second_

Set Clock Parameters

Prompt Parameters

Year Last two digits of the year

Month Number from 1 to 12

Day Number from 1 to 31

Hour* Number from 0 to 23

Minute Number from 0 to 59

Second Number from 0 to 59

*Hour is entered in 24 hour mode (i.e. 1PM would be entered as 13)
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Select Time to add the current time to your label. Use the cursor keys to scroll to the left of Time and
press Enter. The time will be added to the label where the cursor is positioned. The time can be
formatted or deleted just as you had physically typed it in.

1:03:48:33PMn
2:

Select Date to add the current date to your label. Use the cursor keys to scroll to the left of Date and
press Enter. The Date Menu will appear offering 6 formats (mm/dd/yy, dd/mm/yy, mm/dd//yyyy,
dd/mm/yyyy, dd.mm.yy, dd.mm.yyyy). Use the cursor keys to scroll to the left of the format you want
and press Enter.

   Date Menu
n  mm/dd/yy _dd/mm/yy _

The current date will be added to the label where the cursor is positioned. The date can be formatted
or deleted just as you had physically typed it in.

1: 02/01/04 n
2:

Note: Do not confuse the Time and Date options with the Stamp option. Time and Date enters the
current time/date into your label at the insertion point, once entered they are now considered text by
the printer (as if you typed them by hand). The Stamp function will always use the current time
clock at the time of the print job.

Select Stamp to have the current date and time (at the time of print) printed vertically on the very
edge of the label. Every time you press print a stamp with the current date and time will be printed in
ddhhmmMMMyy format. Use the cursor keys to scroll to the left of Stamp and press Enter. This will
turn Stamp on and an asterisk will be displayed. To turn it off, press Enter again.

Note: Using the stamp on tape supply sizes 0.50" 
and smaller is not recommended.

Selecting 24 Hour Mode causes time entered in the text of a label via the Time option to be in 24
hour mode (i.e., 1 PM as 13). Use the cursor keys to scroll to the left of 24 Hour Mode and press
Enter. This will turn 24 Hour Mode on and an asterisk will be displayed. To turn it off, press Enter
again.



Chapter 4

PC Operations
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Introduction

The K5100 will operate either standalone or as a PC printer. This new printer will operate with

Microsoft Windows 98, ME, 2000 or XP. Any standard windows application such as Word, Excel or

other programs can print to the K5100 via a standard Windows printer driver.

Kroy also includes the Kroy Label Designer Software (KLDS) application with your printer that

contains easy to use, preformatted templates for your printer.

The communications between your printer and your PC are controlled by a windows printer device

driver.

The printer device drivers are located on the included software CD-ROM or current drivers are

available at www.kroy.com
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KLDS Software and Driver Installation

Installing the KLDS Software

Close all programs prior to installation. Insert the Kroy Label Designer into the CD-ROM drive. On

most systems the installation program will automatically start. See the steps below to help you along

with your setup.

1. The InstallShield Wizard will appear and prepare to install.

2. Kroy Label Designer Setup will appear. Click Next to continue installation.

3.  The License Agreement will appear: Click Yes.

4. Choose the Destination: the default will be C:\Program\Kroy Click Next.

5. You will then choose the Setup Type. The default is Typical and is recommended for most users.

Click Next.

6. Click Finish to complete.

Installing the Printer Drivers

The drivers for the KLDS will automatically setup. You will see the following prompts once the

software portion is complete.

1. Do you wish to install Kroy Printers. Click Yes.

2. The Kroy Printer Driver Setup will then appear. Click Next to continue.

3. You can now select to add your Kroy Label Printer under Setup Type. Click Next to continue.

4. Select the mode of printer installation. Choose Automatic and connect the printer to your PC

using the serial cable. Turn the printer on.

5. Setup will then scan the COM ports on your system for the new printer, Click Next.

6. Name your Kroy Printer and select it as your default label printer by selecting Yes. Click Next.

7. Recommended Port Setting will appear and click OK.

8.   Click Finish to complete.
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KLDS Operation

Creating a Label
Double click the KLDS Icon or go to your Start Menu\Programs\Kroy Label Designer and select it. The
main screen will appear.

1. Go to the Label Menu and select Label Setup. Click on the K5100 printer. Click OK to verify.

2. Select the appropriate Supply Type, Size and Label Orientation that you are using in your K5100.
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3. A label template will appear on the Main Menu Screen. Select the Text Tool "A" from the Main 

Tool Bar, click your left mouse button on the label template and input text at the blinking cursor.

4. After creating your label, click on the Print Icon from the top tool bar, or go to the Label Menu

and select Print. Select the number of copies and click OK to print your label.

5. The K5100 will then print your label.

For further assistance, go to the Help Menu of your KLDS Software.
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Downloading Fonts

Downloading a Font
The K5100 has the option of downloading fonts from the PC into your Font Menu. Follow the steps
below.

1. Connect the serial cable to the com port of choice and to your printer.

2. Go to the Start Menu of your PC and go to Settings and select Printers.

3. Right click on the K5100 driver and go to Properties.

4. Click on Control and go to Advance Options.

5. Select Download Fonts from the Menu and click Update.
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6. Go to the Font folder on the C drive of your PC and click OK.

7. Select the Font or Font Family of your choice and click OK.

8. The LCD Display of the printer will show the progress of the download using the pound sign(#)

across the bottom. The printer will show a receiving and an updating display.

   Receiving…    Updating…
   # # # #    # # # #

9. The download is now complete and you can find the font in your Font Menu. Press the Delete

key to accept the current Block font or use the left and right cursor keys to move the cursor to the

left of the font you want and press Enter to select it.

                 Font Menu
         n Block_times_arial
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Using Your Printer with Other PC Applications

You may also use other Windows applications to create labels with the K5100 printer. This is an

example using Microsoft Word to create a label.

1. Click on the File menu and select Print.

2. Select the Kroy K5100 Label Printer in the drop down box and Click Close.

3. Click on the File Menu and select Page Setup.

4. Click on the Paper Size tab and select the supply type. This size should match the size of the

width on the supply cartridge currently installed in your K5100 printer. Usually you will want

Landscape orientation selected.
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5. Select the Margins tab and change the top, bottom, left, right, gutter, header and footer to "0" or

desired margin values. The default margins must be changed since you are not printing to a full

8.5" x 11" page. For some media, Word will want to "Fix" the margins based on the maximum

printable area of the media selected. In this case, 1" tape requires a 0.05" top and bottom

margin. Click on OK.

6. It is recommended to click on the View menu and select Page Layout mode.

7. A blank label template with a blinking cursor will appear on your PC monitor.

8. Enter the label text.

9. Select Print from the File menu. Make sure that the K5100 is selected and Click OK to print the
label. Note: When printing and the cartridge runs out of tape, remove and install a new cartridge,
and press Feed to continue printing. DO NOT TURN OFF THE PRINTER.

To Save your label, go to the File menu and select Save. You can also save the document as a
template to start other label files.
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Appendix A: Maintaining Your Printer

The printer requires no lubrication and only minimal maintenance. Occasional cleaning of the exterior

surfaces and regular cleaning of the printhead and rollers are all that is required. This appendix

explains how to clean these parts of your printer.

Cleaning the Printhead and Rollers

The printhead and rollers should be cleaned after every cartridge. Use isopropyl 90% alcohol on a

soft cotton swab to remove adhesive buildup and tape and ribbon residue. Make sure the alcohol has

evaporated before loading a supply cartridge.

Note: Avoid touching the surface of the printhead with your finger. Acids and oils on your skin will

damage the printhead.
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Appendix B: System Messages

The following are system messages that the K5100 will display and an explanation of each message.

Cannot Save       (1) There is not enough memory to save your file.

No Memory Either delete unneeded files or simplify labels by reducing the amount of 

text or the number of formatting options they contain. (2) You tried to save 

a file to drive B when it is write protected.

Cartridge Empty   Cartridge supply is empty. Install a new cartridge.

Font Size Too Big The point size is too large for the number of lines you have entered. 

Reduce the point size or select fewer lines.

Size Too Small Auto size has calculated a size smaller than the minimum size of 4 pt.

Font Error! You entered the wrong number of characters for the bar code. Check the 

requirements for the type of bar code you are using and enter the correct 

number of characters.

No Cartridge Install a cartridge in order to print.

No Files Found You selected Open or Delete but have no files saved in memory. You 

must save files before you can open or delete them.

Printer Too Hot The printer is too hot to print labels. Wait about five minutes and then 

resume printing. This message may also appear when the printer is used 

in an ambient temperature below its minimum rated operating temperature.

Printing… The printer is printing labels. No action required.
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Appendix C: Troubleshooting

This appendix explains how to solve some common problems that may arise when you are using the
printer. If you are unable to correct the problem, contact your Dealer or Kroy Customer Service. In the
United States, call (800)347-5769; in Europe call +44-(0) 118-986-5200.

Display stays black/blank after

printer is turned on

Printer does not print

Printed characters are not

formed properly

Printed characters have a line

through them and/or voids

Printer isn't working properly

Printer has locked up

• Adjust the LCD Contrast

• Make sure the AC Adapter is firmly connected or the optional

  batteries are fully charged

• Ensure the lock/release knob is in the locked position

• Check the supply cartridge and its position

• Check that the AC adapter and/or serial cable is firmly

connected

• Adjust the print density

• Clean the printhead and rollers

• Turn off printer and use a Kroy Cleaning a Kit (Part#255900) or

use 90% or better isopropyl alcohol on a cotton swab to clean

the printhead and rollers (See Appendix A) for instructions

• Reset the printer

• Turn the printer on and off

• Turn the printer on and off
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Appendix D: Updating Firmware

Updating Firmware

Updates for firmware can be found at www.kroy.com. Go to support and click on downloads.

1. Connect the serial cable to your Com port of choice and to your printer.

2. Download the updated file from our site.

3. Save the file to your PC.

4. Go to your Start Menu of your PC and go to Settings and select Printers.

5. Right click on the K5100 driver and go to Properties.

6. Click on Control and go to Advance Options...

7. Select Download Firmware from the menu and click Update.

8. A warning will appear below and click Yes to continue.
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9. Select the firmware file and click Open.

10. The printer will then update the file.

The LCD Display will show the progress of the download using the pound sign(#) across the
bottom. The printer will show a receiving and an updating display.

   Receiving…                Updating…
   # # # #                # # # #

9. The download is now complete.
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Appendix E: Using Accent Characters

K5100 has a variety of international characters and symbols found in Blue on the keypad. Use the Alt

key + the accent character and/or symbol to print out these special accent characters.

In our example, we will use the ? accent character and add it to the letter "i" in "Factoría" (Factory).

The "i" in "Factoría" must be accented. To do this, you will hold down the Alt +  u   ?    key on the

keypad. This activates the accent character. You will then press the letter "I" on the keypad. The

printer will then display the accented character in the text of the label.

   1:Factoría_
   2:

Accent Character Guide
^ aAeEiloOuU

~ AAnNoO

¨ AAeEiloOuUyY

` AAeEiloOuU

? AAeEiloOuUyY
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Appendix F: Using the Character Map

The K5100 has the capability to accept code to print characters not found on the keyboard. To use
the character map, the Extended Mode must be on. To turn the Extended Mode on press the Alt
and Space Bar together. To turn this mode off, press the Alt and Space key together again. See the
character set below for ASCII codes to assist you.

To enter characters in extended mode, enter the 4 digit code shown in the table below. Most of the
characters will be properly displayed on the LCD. For some characters, a solid block place holder will
display on the LCD, but the selected character will print on the label.



F-1

ASCII Code Character ASCII Code Character ASCII Code Character

0123 { 0204 Ì 0231 ç

0124 | 0205 Í 0232 è

0125 } 0206 Î 0233 é

0126 ~ 0207 Ï 0234 ê

0140 Œ 0208 Ð 0235 ë

0156 œ 0209 Ñ 0236 ì

0159 Ÿ 0210 Ò 0237 í

0162 ¢ 0211 Ó 0238 î

0163 £ 0212 Ô 0239 ï

0165 ¥ 0213 Õ 0240 ð

0168 ¨ 0214 Ö 0241 ñ

0176 º 0215 × 0242 ò

0177 ± 0216 Ø 0243 ó

0180 ? 0217 Ù 0244 ô

0191 ¿ 0218 Ú 0245 õ

0192 À 0219 Û 0246 ö

0193 Á 0220 Ü 0247 ÷
0194 Â 0221 Ý 0248 ø

0195 Ã 0222 Þ 0249 ù

0196 Ä 0223 ß 0250 ú

0197 Å 0224 à 0251 û

0198 Æ 0225 á 0252 ü

0199 Ç 0226 â 0253 ý

0200 È 0227 ã 0254 þ
0201 É 0228 ä 0255 ÿ

0202 Ê 0229 å

0203 Ë 0230 æ
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